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Introduction

What is the CT2X with Pressure Option?

The AquiStar® CT2X is a submersible conductivity/temperature sensor with built-in
datalogging. This device stores thousands of records of conductivity, temperature, and
time data. The CT2X is also available with a pressure option based on INW’s popular
PT2X Smart Sensor, giving added functionality in the same sensor housing.

The CT2X incorporates 4-pole electrode cell measurement technology.  This technology
reduces fringe field interference errors, lessens inaccuracy caused by polarization
effects, and lowers contact resistance problems. Four-pole electrode technology also
allows users to work with one electrode over a wide range of conductivity.

The conductivity probe is constructed of epoxy/graphite, making it extremely durable for
use in rugged field conditions. To clean, simply scrub with a small brush.

The CT2X is powered internally with one 3-volt lithium battery or with an external
auxiliary power supply for data intensive applications.

The unit is programmed using a laptop or desktop Windows® based computer via its
RS485/RS232 connector and easy-to-use Aqua4Plus software.  Once programmed the
unit will measure and collect data on a variety of time intervals.

Initial Inspection and Handling

Upon receipt of your smart sensor, inspect the shipping package for damage. If any
damage is apparent, note the signs of damage on the appropriate shipping form. After
opening the carton, look for concealed damage, such as a cut cable. If concealed
damage is found, immediately file a claim with the carrier.

Do’s and Don’ts

Do handle the device with care.
Do store the device in a dry, inside area when not in use.
Do install a desiccant tube if you are doing long-term outdoor monitoring.

Don’t install the device so that the connector end is submerged.
Don’t support the device with the connector or with the connectors of an extension

cable.   Use a strain relief device to take the tension off the connectors.
Don’t allow the device to free-fall down a well at high velocities as impact damage

can occur.
Don’t bang or drop the device on hard objects.
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Connecting the Sensor to a Computer

In its standard configuration, the Smart Sensor cable is terminated with a waterproof
micro-connector.  Connect this to your PC or laptop serial port via the interface cable
and an RS485/RS232 adapter, as shown below. If your computer does not have a serial
port, you can connect to a USB port using a USB/Serial adapter. See Appendix XXX for
details.

Installing the Aqua4Plus Software

1. Insert the Aqua4Plus CD in the CDROM drive on your PC or laptop. Installation
should start automatically. If not, then follow steps 2 and 3.
Otherwise, skip to step 4.

2. Click the Start button and select Run.
3. Type D:\setup.exe, where D: is the drive letter for your CDROM drive.
4. The Installation program will guide you through the installation process.

To start the Aqua4Plus software, use the Start Menu to navigate to the program group
you selected during
installation (typically this will be Aqua4Plus), and then click the Aqua4Plus icon.

PC or Laptop
Computer

RS485/RS232
Adapter

Interface
Cable

Waterproof
Micro-

Connector

Serial Port

Sensor

Cable
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Using Aqua4Plus

Selecting a COM Port

Select the COM port to which your sensor is connected, by clicking on the down arrow
on the tool bar, and then clicking on the COM port.

Tool Bar

Selecting Units

Readings from the Smart Sensor can be displayed in various different units. To set the
display units, open the Options Menu, and then  select Display Units. Select the units
by clicking on the down-arrows next to Pressure, Temperature, and Conductivity. For
Pressure many options are available, including psi, Ft H2O, and mBars. For Temperature,
select from degrees Celsius, Fahrenheit, or Kelvin. For Conductivity, select from micro-
Siemens per centimeter (µS/cm) or milli-Siemens per centimenter (mS/cm) for conductiv-
ity, or milligrams per liter (mg/L) for total dissolved solids (TDS).

Select Display Units
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Viewing the Sensor

• Open the Sensor Window by clicking the  tool button.
A list of connected sensors will appear on the Sensor Tree. For a CT2X with
pressure option, you will see two sensors listed on the tree--a CT2X and a PT2X.
The CT2X measures conductivity. The PT2X measures pressure. Aqua4Plus
treats the CT2X and the PT2X as separate sensors--they each have their own
temperature channel; they each have their own clock; and each is read separately.

• On the Sensor Tree, click on either the CT2X or the PT2X. Information regarding
the selected sensor will display in the Sensor Information  Panel to the right of
the Sensor Tree.

• Click the + next to the desired sensor on the Sensor Tree. A list of data sessions
stored in the sensor will display in the Sensor Tree below the selected sensor.

Sensor Tree on Sensor Window

Setting Sensor Descriptions

Each sensor on the sensor tree can be assigned a short description. This description is
displayed on the sensor tree and is recorded with collected data. To assign a descrip-
tion, click on the sensor on the sensor tree. Then select the Sensor Description option
from the Configure menu.

Setting Sensor Clocks

Each sensor has its own internal clock. Set this clock by clicking on the sensor, and then
selecting the Sensor Clock option from the Configure menu. A pop-up box displays the
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date/time currently in the sensor. Click the Set From System Clock button to set the
sensor clock to match that of your host computer. Alternately, type in a specific date/
time and click the Set Clock button. INW highly suggests that you set both the CT2X
and the PT2X  clock using Set from System Clock. This will assure that both sensors are
set to the same time.

Calibrating

Field Calibration on the CT2X - Conductivity
The CT2X will need to be calibrated for the type of sampling you will be doing. For this
calibration you will need a standard with a known conductivity at a specific temperature.
For best results, select a standard that is as  close as possible to the expected conduc-
tivity of your samples. If you will be using the nLFn mode for your measurements, you
must use a standard that has a reference temperature of 25 degrees C.

To calibrate, follow these steps:
• Click on the CT2X on the sensor tree.
• Erase any sessions on the sensor. (Be sure to upload any data you want to save

before erasing the sessions.)
• Select the Field Calibration option from the Configure Menu.
• Click on Conductivity. The conductivity field calibration window will appear. (See

next page for illustration.)
• Select reference temperature for standard you are using.
• Make sure the Non-Linear box is not checked, unless using a non-linear calibra-

tion standard.
• Enter the Temperature coefficient (2.1 for a wide variety of fluids). (Not needed if

using a non-linear calibration standard.)
• Enter TDS factor, if other than default of .49 (if measuring TDS).
• Rinse probe with your standard.
• Dry with clean paper towel and cotton swab.
• Place probe in standard.
• Make sure there are no bubbles in the conductivity slot.
• Allow to thermally stabilize.
• Click Measure button. A measurement box will pop up.
• When readings are stable, click OK on measurement box.
• If reading does not match that of your standard, use the spinner to adjust cell

constant until reading matches that of your standard.
• Click the Apply button to transfer the new CELL constant to the calibration field.
• If you will be using the non-linear mode for your sampling (for instance for

measuring in natural water), checkmark the Non-Linear checkbox at this time.
• Click the OK button to save calibration values to the sensor.



8

Field Calibration Window for Conductivity

Field Calibration on the CT2X - Temperature
The temperature channel on the CT2X rarely needs calibration in the field. If you do
need to adjust its calibration, one- and two-point calibration can be performed from the
Field calibration window as follows:

• Click on the CT2X on the sensor tree.
• Erase any sessions on the sensor. (Be sure to upload any data you want to save

before erasing the sessions.)
• Select the Field Calibration option from the Configure Menu.
• Click on Temperature.
• Follow the instructions that appear to the right of the calibration window.

Field Calibration on the PT2X - Pressure and/or Temperature
Before shipping, the pressure channel on the PT2X has been calibrated using sophisti-
cated environmental chambers and deadweight testers. As the sensor can drift slightly
over time, it may occasionally need field calibration. The temperature channel rarely
needs calibration in the field. If either the pressure or the temperature needs to be
calibrated, one- and two-point calibration can be performed from the Field Calibration
window as follows:
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• Click on the PT2X on the sensor tree.
• Erase any sessions on the sensor. (Be sure to upload any data you want to save

before erasing the sessions.)
• Select the Field Calibration option from the Configure Menu.
• Click on Pressure or Temperature, depending on which you are calibrating.
• Follow the instructions that appear to the right of the calibration window.

Taking Real Time Readings

Use the Real Time Monitor (lower part of Sensor Window) to view live readings from the
sensor that is selected on the Sensor Map. These readings are not being recorded in the
sensor, but only displayed for real time viewing. The Real Time Monitor can be used
whether or not the sensor is actively recording a session.

To obtain and display a single reading, click the Single button.

To obtain and display readings continuously for 60 readings, click the Start button.

To stop the monitor, click the Stop button.

Real Time Monitor on Sensor Window
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Recording Data

Before you can collect data in the logger, you must create a Session Profile, which
describes the type and duration of records to record. The CT2X and the PT2X portions
must be programmed separately. (If you will be correlating the data from both sensors,
then before starting a recording session, set the clocks in both the CT2X and the PT2X
to the same time using the Sensor Clock option on the Configure Menu.)

Create recording sessions as follows:
• Select the sensor you want to program from the Sensor Tree.
• Start a new session: Click the  tool button.

A Session Profile Window will open. (See illustration top of next page.)
• Name your session: Enter a name in the Session

ID box, or leave as is to accept the default name.
• Describe a test phase:

° Click the number at the beginning of the test phase.
° Use the Tab key on the keyboard to move to the sample interval column,

and enter your sample interval for this phase as dd/hh:mm:ss.
° Enter the number of samples to record at this sampling interval , then press

the Tab key. You will automatically move to the next phase’s sampling
interval field.

° Continue entering  phases as above.
• If you will be correlating the data from both sensors, follow the Delayed Start

instructions below. Otherwise, skip this step.
° Click the Delayed Start checkbox.
° Enter the date and time you want the test to start. (Time is in 24 hour

format.)
• Start the test: Click the Start button. Your session will appear on the sensor tree

with a green light in front of the session name. (If you have selected a delayed
start, your session will appear with a clock face in front of the session name.)

For more detailed information on creating sessions, refer to the Aqua4Plus
Control Software Instruction Manual.
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Retrieving Data

• On the Sensor Tree, click on the session you want to upload.
• Click the   tool button.
• Select a file location and enter a name for the file.
• Click Save.
• Click Start.

Viewing Data

• Click the   tool button to view data as a table.
• Click the   tool button to view data as a graph.
• Navigate to the desired file, then click the Open button. (If the File Open box

does not appear, click the File Menu, then select Open.)
(See illustrations of table and graph formats on next page.)

Session Profile Window
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File Display Window

Graph Window
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Exporting Data

• Using the File Display window, open the file you want to export.
• Click on the   tool button.
• Select a file location and enter a name for the file or leave as is to accept the

current file name.
• Select a file type. Files can be saved in either Text (.csv) or Excel (.xls) formats.

Select the file type from the drop-down Save-as-type box. (.xls formatted files
can be opened in Excel. .csv formatted files can be opened in Excel and most
other popular spreadsheets, databases, and word processors.)

• Click Save. You will be given the option of viewing it in Excel. (Note, you must
have Excel installed on your machine in order to make use of this option.)

Importing Data Into a Spreadsheet

To import data to a spreadsheet or database, you must first Upload and Export the data
to a .csv file. (See previous sections on uploading and exporting.) Most spreadsheets
and databases can readily import .csv files. Microsoft® Excel can import either .csv or
.xls files.  Following are instructions for importing a data file into Excel. For importing
into other programs, see documentation with the particular program.

1. Open Excel.
2. Click on the File menu, and the select Open.
3. On the Open dialog box, click the down-arrow to the right of the Files of Type

field. (This is the last field on the dialog box.)
4. Click the option All Files.
5. Navigate to the saved file, and then click the Open button in the lower right

corner of the dialog box.

The data will be opened in Excel. (Note: While Aqua4Plus can handle over 130,000
records, Excel is limited to approximately 65,000 records.)
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Appendix A: Grounding Issues

It is commonly known that when using electronic equipment, both personnel and
equipment need to be protected from high power spikes that may be caused by light-
ning, power line surges, or faulty equipment. Without a proper grounding system, a
power spike will find the path of least resistance to earth ground – whether that path is
through sensitive electronic equipment or the person operating the equipment. In order
to ensure safety and prevent equipment damage, a grounding system must be used to
provide a low resistance path to ground.

When using several pieces of interconnected equipment, each of which may have its
own ground, problems with noise, signal interference, and erroneous readings may be
noted. This is caused by a condition known as a Ground Loop. Because of natural
resistance in the earth between the grounding points, current can flow between the
points, creating an unexpected voltage difference and resulting erroneous readings.

The single most important step in minimizing a ground loop is to tie all equipment
(sensors, dataloggers, external power sources and any other associated equipment) to a
single common grounding point.  INW recommends connecting the shield to ground at
the connector end.
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Appendix B: Technical Specifications

Wiring Information

Cable Type: 9-conductor, vented
Shield = Ground
White = Vaux (5.5 to 15 VDC)
Brown = Digital out
Blue = Ground
Yellow = Comm D+
Purple = Comm D-

Conductivity/Temperature Module

BODY

Body Material 316 stainless steel
Probe Material Epoxy/Graphite
Electrode 4-pole
Wire Seal Materials Viton® and Teflon®

Terminating Connector Available
Weight Less than 1 lb.

CABLE

OD 0.28” maximum
Break Strength 138 lbs.
Maximum Length 2000 feet
Weight 4 lbs. per 100 feet

CONDUCTIVITY

Static Accuracy ±0.5% of measured value
Resolution 0.1 for microSiemens

0.001 for milliSiemens
TDS 0 - 2000 mg/L
Cell Constant .55 (standard)

TEMPERATURE

Accuracy ±0.2° C (at 25° C)
Resolution 0.1° C

TIME

Accuracy ±6 sec/day (maximum)
±2 sec/day (typical)

Operating Temp. Range   0° C to 80° C
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Pressure/Temperature Module (Optional)

BODY

Body Material 316 stainless steel
Wire Seal Materials Viton® and Teflon®

Terminating Connector Available
Weight Less than 1 lb.

CABLE

OD 0.28” maximum
Break Strength 138 lbs.
Maximum Length 2000 feet
Weight 4 lbs. per 100 feet

PRESSURE

Static Accuracy ±0.1% FSO (maximum)
(B.F.S.L. 25° C)* ±0.06% FSO (typical)

Temperature Error ±0.5% FSO (maximum)
(reference 25° C) ±0.25% FSO (typical)

Maximum ±0.25% FSO
Zero Offset at 25° C

Resolution 16 bit
Ranges various from 5 - 300 psi -

absolute and gauge
Over Range Protection 2x (except 300 PSIA)

TEMPERATURE

Accuracy ±0.75° C (maximum)
Resolution 0.1° C

TIME

Accuracy ±4 min/yr (maximum)
±2 min/yr (typical)

Operating Temp. Range   0° C to 40° C
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Appendix C: Using USB to Serial Cables
The standard communication cable/RS485-232 adapter that comes with the Smart Sensor
plugs into a 9-pin serial port on the PC or laptop. Many new computers, especially
laptops, do not come with 9-pin serial ports. If you have one of these computers, or if all
of your serial ports are in use, you can connect to a Smart Sensor using a USB to Serial
adapter, as shown below.

Connection using a USB to Serial Cable

USB-to-Serial cables are readily available from many electronics and computer stores, as
well as numerous sites on the Internet.  INW has tested and recommends the Keyspan
USA-19HS. It is available from INW or from CompUSA.

Install as follows:
• Plug into USB port
• Install the drivers provided with the particular unit
• Determine the port number to which the adapter assigned

o Right-click on My Computer
o From the popup menu, select Manage to open the Computer Manage-

ment window
o On left panel, click on Device Manager
o On right panel, double-click on Ports
o A list of active COM ports will be displayed. Note the COM number

assigned to the adapter you just installed.

For example:  
o Close Manager.

• Connect to the Smart Sensor
• On the Aqua4Plus software, select the COM port. (Note: if you do not see your

new COM port in the drop-down box, open the Communications dialog box
from the Options menu. Increase the Highest COM port number.)

Interface
CableWaterproof

Connectors

PT2X

PT2X
Cable

PC or Laptop
Computer

USB Port
USB to Serial

Cable

RS232/RS484
Adapter
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LIMITED WARRANTY/DISCLAIMER - AquiStar® PT2X and CT2X
SUBMERSIBLE PRESSURE and CONDUCTIVITY SENSORS

A.   Seller warrants that products manufactured by Seller when properly installed, used
and maintained with a properly installed desiccant tube, shall be free from defects in
material and workmanship.   Seller’s obligation under this warranty shall be limited to
replacing or repairing the part or parts or, at Seller’s option, the products which prove
defective in material or workmanship within ONE (1) year from the date of delivery,
provided that Buyer gives Seller prompt notice of any defect or failure and satisfactory
proof thereof.   Any defective part or parts must be returned to Seller’s factory or to an
authorized service center for inspection.   Buyer will prepay all freight charges to return
any products to Seller’s factory, or any other repair facility designated by Seller.   Seller
will deliver replacements for defective products to Buyer (ground freight prepaid) to
the destination provided in the original order.   Products returned to Seller for which
Seller provides replacement under this warranty shall become the property of Seller.

This limited warranty does not apply to lack of performance caused by abrasive materials,
corrosion due to aggressive fluids, mishandling or misapplication.   Seller’s obligations under
this warranty shall not apply to any product which (a) is normally consumed in operation, or (b)
has a normal life inherently shorter than the warranty period stated herein.

In the event that equipment is altered or repaired by the Buyer without prior written approval by
the Seller, all warranties are void.   Equipment and accessories not manufactured by the Seller
are warranted only to the extent of and by the original manufacturer’s warranty.

THE FOREGOING WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES,
WHETHER ORAL, WRITTEN, EXPRESSED, IMPLIED OR STATUTORY.   IMPLIED
WARRANTIES OF FITNESS AND MERCHANTABILITY SHALL NOT APPLY.   SELLER’S
WARRANTY OBLIGATIONS AND BUYER’S REMEDIES THEREUNDER (EXCEPT AS TO
TITLE) ARE SOLELY AND EXCLUSIVELY AS STATED HEREIN.   IN NO CASE WILL
SELLER BE LIABLE FOR CONSEQUENTIAL DAMAGES, LABOR PERFORMED IN
CONNECTION WITH REMOVAL AND REPLACEMENT OF THE SENSOR SYSTEM,
LOSS OF PRODUCTION OR ANY OTHER LOSS INCURRED BECAUSE OF INTERRUP-
TION OF SERVICE.   A NEW WARRANTY PERIOD SHALL NOT BE ESTABLISHED FOR
REPAIRED OR REPLACED MATERIAL, PRODUCTS OR SUPPLIES.   SUCH ITEMS
SHALL REMAIN UNDER WARRANTY ONLY FOR THE REMAINDER OF THE WAR-
RANTY PERIOD ON THE ORIGINAL MATERIALS, PRODUCTS OR SUPPLIES.

B.   With respect to products purchased by consumers in the United States for personal use, the
implied warranties including but not limited to the warranties of merchantability and fitness for a
particular purpose, are limited to twelve (12) months from the date of delivery.

Some states do not allow limitations on the duration of an implied warranty, so the above
limitation may not apply to you.   Similarly, some states do not allow the exclusion or limitation
of consequential damages, so the above limitation or exclusion may not apply to you.   This
limited warranty gives you specific legal rights; however, you may also have other rights which
may vary from state to state.
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